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Chapter 1: Introduction

Congratulations on purchasing the ViewSonic V38r. The V38r
is a Windowse powered Rugged Handheld that enables you to
keep your most important business and personal information
up-to-date and close at hand. This chapter introduces you to
the internal and external components of the V38r and gets the
unit setup.

Package Contents

When you unpack the contents of the V38r, verify that you have
all of the items listed below.

The ViewSonic V38r with attached front cover
Quick Start Guide

V38r battery

AC power adapter

USB cable

Stylus (1)

Stylus tether (1) detached

Communication and power dongle with one USB-A mini and
one USB-B ports and a serial (RS232) port with power input

V38r Companion CD

Go to the Help and Support Center on your PC for details
on using Microsoft software. This manual only covers
using the ViewSonic V38r hardware.

ViewSonic Rugged Handheld 1



Optional Accessories

The following optional accessories are available from
ViewSonic:

e Desktop cradle (also called dock) with battery charging and
communication

e WLAN/Bluetooth (depending on model)

e Camera for snapshots (depending on model)
e Car adapter cradle

e Avalon RF

e RFID

e Extended battery with extended back cover
e AC power dongle

e Belt clip

e Hand strap

e Fingerprint sensor (depending on model)

e Flip cover

Features

e V38r Rugged Handheld

e Dock/cradle connector for optional cradle for input devices
e Wireless 802.11g

e 1D CCD Bar-Code scanner

e Standard joy stick

e SD card slot for extended memory

e Rechargeable battery (Lithium Ion)

e Color display and touch screen

e Synchronize data between desktop/laptop computer and
your V38r

e Microphone to record messages, internal speaker
e Fingerprint sensor (depending on model)

ViewSonic Rugged Handheld 2



Software Installed

The following software is already installed on the V38r PPC
2003:

Internet Explorer

Windows Explorer

Media Player

MS WordPad

Solitaire

Microsoft Inbox

Microsoft ActiveSync*

Microsoft File Viewers
e MS Excel Viewer

MS Image Viewer

MS PDF Viewer

MS PowerPoint Viewer
MS Word Viewer

Your company’s software development department most likely
already installed and set up all software necessary for your
V38r to perform its designated function(s) in the field.

* If you want to synchronize your V38r with your PC,
download the latest ActiveSync from the Microsoft website
to your PC. ActiveSync may be on a CD that came with your
V38r depending on the model. For detailed instructions, look
for the step in this guide to Install MS ActiveSync on your
PC.
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Parts of the V38r

The illustrations on the next few pages introduce you to the
various buttons, connectors, ports, and other features of your
V38r.

for details on using Microsoft software. This
manual only covers using the ViewSonic
V38r hardware.

2 Go to the Help and Support Center on your PC

Front and Bottom Views

@ Fingerprint sensor

© Power Status LED

(depending on model) (Battery or AC)
© GPS Antenna Antenna LED
o Speaker (wireless antenna)
Scan buttons
hsi
@ Display/Touch Screen g??ﬁeoge%?ge)s'de

00

(preview in Camera
mode, or preview what
you scanned in Scan
mode)

@ Joy stick/
ENTER button

Calendar
Contacts (programmable)
Power button @ 1o Do screen

Today Microphone

@ Docking/Power Interface Port from:
* Power
e Communication Devices
* Dock/cradle (optional accessory)
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Ref Part Description

o Fingerprint (programmable button) used for fingerprint
sensor recognition. Availability depends on model.
Antenna GPS (Global Positioning System) antenna.
Speaker Internal speaker sends out music or
audible reminders and alerts.
Display /Touch Screen (preview in Camera mode,
or preview what you scanned in Scan mode
Contacts Keep track of your friends, family,

colleagues, and associates with phone
numbers, email addresses, etc.

Power button

Turns the V38r On or Off. When turned off,
the unit is in suspend mode for up to 5
minutes while changing batteries.

© © 6| 660 0|0

Today The main screen on the desktop. select
something from the Today screen to add or
change the details about tasks, etc.

IN port (programmable button). Signal coming into

the V38r from AC power source,
communication devices, or the optional
dock/cradle.

Power Status
LED

Charging the battery and AC power.

Antenna LED

Wireless antenna LED.

Scan button

Bar Code Scan.

Navigation

Joy stick/ENTER button. Move up, down,
left, or right in a document.

® 60 686 60

Calendar

(programmable button) a quick way to run
the Calendar program. See the section in
this guide on Pocket Outlook to schedule
appointments, meetings, manage your
Contacts list, keep a To Do list, make
Notes.

e

To Do

Your To Do list.

®

Microphone

Records sound and/or voice messages.
See the section in this guide on Recording
a Message.
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Back and Top Views

@ Barcode scanner

/——Q 1.3M camera
Button for: — @ Camera shutter

¢ Bar Code Scan release
e Camera shutter
release 2 @) Camera flash ON/OFF

@sStandard battery
compartment
back cover

) O Unlock icon
4@ Release button to

back cover
Lock icon
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Ref

Feature

Barcode scanner

Description

1D CCD

Stylus slot

Store the stylus here.

Camera shutter
release or scan

One of two buttons to take a picture or
scan. Press both buttons at the same time -
one on each side of the V38r.

Back cover

This example shows a flat back cover to
cover a standard battery. The extended
battery is bigger and has a bigger cover.

© © 0 0 ¢

1.3M camera

CMOS camera. In camera mode, press the
left and right "SCAN” buttons to snap
pictures. Pictures can be viewed in portrait
mode and saved to SD card.

Camera shutter
release or scan

Take a picture or scan. Press the two
buttons at the same time - one on each side
of the V38r.

Camera flash ON/
OFF

Turns camera flash on and off.

Unlock icon

Turn the release latch to the unlock icon to
unlock the cover to the battery
compartment.

Release button for
back cover

Locks and unlocks back cover to the battery
compartment.

e 6| 60 ©

Lock icon

Turn the release latch to the lock icon to
lock the cover to the battery compartment.
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Side Views

@ Camera shutter

release & scan '
e SD slot cover T

O Screw to release
SD slot cover

Ref Part

Camera shutter
release or scan
button

°y

Camera shutter
release

l—e IrDA

Description

In camera mode, press the left/right SCAN
buttons to snap a picture and save the picure
to an SD card.

Camera shutter
release or scan
button

In camera mode, press the left/right SCAN
buttons to snap a picture and save the picure
to an SD card.

SD slot cover

SD (Secure Digital) card slot for extended
memory.

Screw to release
SD slot cover

Releases cover to SD card slot.

IrDA

0/ 0 0 ©

Infrared Communication.
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Initial Setup

Your V38r features powerful software and hardware allowing
you to connect to your PC to view and edit files, wirelessly
send/receive e-mail, and explore the World Wide Web. This

section shows you how to get started.

Go to the Help and Support Center on your PC for
A details on using Microsoft software. This manual
only covers using the ViewSonic V38r hardware.

1 Install the battery

If the battery is already in the V38r when you open the
package, go to Step 2. If not, then remove the back cover
by turning the latch counterclockwise as shown below.
Slide the battery into the battery compartment lining up
the pin connections. Replace the back cover and tighten
the latch clockwise.

Back cover
for standard
battery

Unlock latch Align the pin Lock latch
connections

ViewSonic Rugged Handheld 9



2 Remove the front cover

Pinch and slide the cover off the front of the V38r as
shown. The cover is attached, so just let it hang loose.

Two hands One-handed:
push up with thumb

3 Plug into AC power

Caution: Use only the cords that came with your V38r.
Pinch the sides of the AC power dongle while plugging the
dongle into the port on the bottom of the V38r as shown
below. Attach the dongle to the AC power dongle and the
AC power dongle into an AC power wall outlet.

AC power
wall outlet

ViewSonic Rugged Handheld 10



Battery & Power Properties

Your V38r has three possible power sources, AC (using the AC

power dongle or the optional dock/cradle) or battery. Only use

the dongle(s) and/or cable(s) that came in the package.

EAUTION: Replace only with one of the following V38r series
atteries:

Standard Battery part humber: BAT-001
Extended Battery part number: BAT-002 (4 hours added life)

Initial Charging: Failure to fully charge the battery
overnight before turning on the V38rfor the first time may
reduce the overall service life of the battery.

The V38r recharges in approximately two (2) to (3) three hours
while not in use and four (4) hours while in use. Normally, V38r
operates on battery power alone. A fully charged battery can
last up to four (4) hours depending on power consumption
factors such as the screen’s brightness setting.

If the battery is left unattended too long, it may discharge
completely. Complete discharge may damage the battery’s
ability to recharge properly.

Storage: If you are not using the V38r on a daily
A basis, store the unit by plugging it into an AC outlet

Remove the back cover by turning the latch counterclockwise
then take the battery out. CAUTION: Removing the battery
can cause the loss of content not saved in the Persistent
Storage folder. Before removing the battery, we strongly
recommend that you do one of the following:

e Drag any changed files you want to protect to the V38r's
Persistent Storage folder (under My Computer), then press
the Power button (to turn the V38r off/Suspend Mode)
before removing the old battery.

Or,

¢ Plug the AC Power Cord into the V38r before removing the
old battery to prevent a disruptive interruption of power.

Or,

e Press the Power button to put the V38r in Suspend Mode,
remove the old battery, and insert the replacement battery
quickly. The backup battery (permanently installed) will
prevent an interruption of power, providing a maximum of
five (5) minutes of power while in Suspend Mode.
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4 Charge the battery overnight

Before using the V38r for the first time, charging the
battery overnight is best to ensure the battery is fully
charged. After the battery is fully charged the first time,
you can charge, recharge, and/or operate your V38r with
available AC power using the AC power dongle.

5 Turn the power on

Press the Power Button. The Power Status LED turns
green.

Wireless Antenna LED —

Green = excellent
Yellow = good signal
Blinking Yellow = very low

Power Status LED

(same for the battery in the docking station)
Green = fully charged

Solid Red = charging

Blinking Red = error

Power button

To determine the main battery’s current charge level,
double-tap the Power icon in the Control Panel window
under My Computer. The Power Properties window opens
to Battery Status. Battery Status displays the percentage
of power left in your main battery and rates the quality of

your external power connection and backup battery as
either Good, Low, or Very Low.

ViewSonic Rugged Handheld 12



6 Install MS ActiveSync on your PC

Microsoft ActiveSync enables you to synchronize and
update the data between your PC and your V38r.
ActiveSync is already installed on your V38r but needs
to be installed on your PC.

IMPORTANT: Before installing ActiveSync, make sure
Microsoft Outlook is installed on your PC. If not, you can
install Outlook 2002 from the provided ViewSonic
V38r Companion CD.

1 Turn on your PC.

2 Insert the Microsoft ActiveSync Utility CD
(depending on model) into the CD-ROM drive of your
PC. Or download ActiveSync from the Microsoft
website. The ActiveSync installation screen should
open immediately. If not, double-click Setup.exe and
go to Step 3.

3 Click the arrow on the first screen to enter the main
screen. Click Start Here, then click Install
ActiveSync. Click Install to start the installation.

4 When prompted, connect your V38r to your PC as
shown below:

(1) Plug the dongle with the USB port into the V38r.

(2) Plug the USB cable into the USB port on the
dongle.

(3) Connect the AC adapter to the power connector
on the USB plug.

(4) Connect the USB cable to your PC. The Found
New Hardware Wizard appears.

Computer

ViewSonic Rugged Handheld 13



5 Follow the on-screen instructions to synchronize the
V38r with your PC. After the first synchronization, the
data you have stored on your PC, such as Calendar,
Contacts, and Tasks, is copied to your V38r. You're
now ready to take it along with you when you go. For
more information on ActiveSync, see the MS
ActiveSync section in this guide.

For More Information

For information on: See this source

Operating the V38r

V38r Hardware Guide (a PDF file on the
ViewSonic V38r Companion CD.)

Programs on your V38r

V38r Hardware Guide and Help on your PC.

Additional programs that can
be installed on your V38r

ViewSonic V38r Companion CD

Connecting to and
synchronizing with a PC

V38r Hardware Guide or online Help. Tap
Help on the Start menu to view Help.

ViewSonic Customer Support

Customer Support section in the Appendix of
this guide

Troubleshooting

See the Troubleshooting chapter later in this
guide

Last-minute updates and
technical information

The Read Me files in the “Microsoft
ActiveSync” folder on your PC or the
ViewSonic V38r Companion CD

The latest on Windows
Powered devices

The Microsoft Mobile Devices Web site:

- ; /mobile/

ViewSonic Rugged Handheld
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Introducing the Stylus

Use the stylus to “tap” or “"double-tap” on an application icon
and to select items on the menu. The stylus is also used to
“type” on the Input Panel and to write notes when in
handwriting recognition mode. The stylus that is supplied with
your V38r is designed for your screen. Using other pointers
could damage your screen and may void the warranty.

I
o>

When not in use, you can conveniently place your stylus in the
storage slot located on the top edge of your V38r. To keep from
loosing the stylus, attach the stylus tether that came in the
package to the bracket on the back of the V38r.

Stylus T
—  Bracket

Stylus tether ‘\

Moving Windows

1 To move a window on the screen, press on the Window's title-
bar gently with the stylus.

2 Drag the window slowly to a new location.

ViewSonic Rugged Handheld 15



Calibrating the Touch Screen

If your touch screen is not responding accurately to taps with
the stylus, you can recalibrate the screen as follows.

1 Tap Windows Start.

2 Tap the Settings button > Control Panel icon > Stylus >
Stylus Properties > Calibration > Recalibrate (the
crosshairs appear).

3 Follow the on-screen instructions to place the stylus on a
cross-hair. Rather than just tapping the screen, hold the
stylus in place for a second or two as directed until the

program responds. Repeat this at each corner of the screen.

4 When finished, tap the screen. Re-calibration is complete.

ViewSonic Rugged Handheld
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Adjusting the Stylus Double-tap Rate

The double-tap rate can also be adjusted in the Settings
window:

1 Tap Windows Start.

2 Tap the Settings button > Control Panel icon > Stylus >
Stylus Properties > double-tap on the checkerboard
graphic to set your double tap rate.

3 Close the Settings window.

4 To save your settings, press the Power button which puts
the V38r into Suspend mode. Wait momentarily. Press the
Power button again and resume working.

Using the Stylus

Use the stylus to navigate and select objects on the V38r touch-
screen. You can extend the stylus to hold it more comfortably.

e Tap: Touch the screen once with the stylus to open items
and select options.

e Drag: Hold the stylus on the screen and drag across the
screen to select text and images. Drag in a list to select
multiple items.

¢ Press and hold: Press and hold the stylus on an item to
see a list of actions available for that item. On the pop-up
menu that appears, tap the action you want to perform.

ViewSonic Rugged Handheld 17



Chapter 2: Using your V38r

This chapter introduces you to the basics of working with
programs and documents on your V38r.

Today Screen

When you turn on your V38r for the first time each day (or
after four hours of inactivity), you will see the Today screen.
On the Today screen, you can see at a glance important
information for the day: current date, appointments, activities,
new email, and create new documents.

You can also display the Today screen by tapping [ and then
tapping Today.

Navigation Bar Shows Connection Status to host PC or
wireless network
Tap to switch

Tap to change Volume or Mute sound
to a program.

coming from speaker.

Friday, March 21, 2003
Tap here to set awner information

Tap to change date and time.
Tap to open an item.

@
S|

Mo upcorming appointments

Your day at a glance

Tap to create a new item.

Command Bar

ViewSonic Rugged Handheld 18



Status Icons

e When the Today screen is displayed, you may see the
following status icons on the Command bar or Navigation
bar. In most cases, you can tap a status icon to display the
associated control panel or more information related to the
item.

e For example, tap rato see information about the battery
status.

lcon Meaning

asp  |Active Connection: there is an active
4 |CONNection to host PC or wireless network.

aep  |INActive Connection: there is not an active
q...x connection to host PC or wireless network.

» |Speaker is On.

_‘x Speaker is Off.

Main battery is low.

Main battery is very low.

Main battery is fully charged.

Synchronization is beginning or ending.

ViewSonic Rugged Handheld 19



Navigation Bar and Command Bar

The Navigation bar is located at the top of the screen. It
displays the active program and current time, and allows you to
switch programs and close screens.

The Navigation bar and Start menu:

Shows Connection Status to host PC or
wireless network

Tap to change Volume or Mute sound.

oF o< 19:05

Tap to quickly select a program
you have recently used.

Tap to select a program.

Tap to see additional programs.
Tap to customize the device.

Use the Command bar at the bottom of the screen to perform
tasks in programs. The Command bar includes menu names,
buttons, and the Input Panel button. To create a new item in
the current program, tap New. To see the name of a button,
press and hold the stylus on the button. Drag the stylus off the
button so that the command is not carried out.

The Command bar:

New button Input Panel button
| |
INew Edit Tools 1|2 =g
| Buttons
Menu names

ViewSonic Rugged Handheld 20



Running Programs

Depending on the program you want to run, you can:

e Tap [ or tap Start at the top of the screen and select from
the menu. (You can customize which programs you see on
this menu. For information, see section “"Customizing Your
V38r” in Chapter 3).

e Tap [ and then tap Programs to access additional
programs. Tap the icon to run the program.

e Press program buttons on the front of your V38r to open
the program. The icons on the buttons identify the
programs they are associated with. (You can customize
which programs are associated with the buttons. For
information, see the section “"Customizing Your V38r” in this
guide).

The following table contains a partial list of the program icons
on your V38r.

lcon Program Description
ActiveSync Synchronize information between your V38r and PC.
Calendar Keep track of your appointments and create
meeting requests.
Contacts Keep track of your friends and colleagues.
Inbox Send and receive email messages.

Pocket Internet Browse Web and WAP (Wide Area Protocol) sites,

Explorer and download new programs and files from the
Internet.

Notes Create handwritten or typed notes, drawings, and
recordings.

Tasks Keep track of your tasks.

Pocket Excel Create new workbooks or view and edit Excel

workbooks created on your PC.

| B0 6P| E®

Pocket Word Create new documents or view and edit Word
documents created on your PC.

£

ViewSonic Rugged Handheld 21



Pop-up Menus

With pop-up menus, you can quickly choose an action for an
item. For example, you can use the pop-up menu in the contact
list to quickly delete a contact, make a copy of a contact, or
send an email message to a contact. The actions in the pop-up
menus vary from program to program. To access a pop-up
menu, press and hold the stylus on the name of the item that
you want to perform the action on.

When the menu appears, lift the stylus, then tap the action you
want to perform. Or tap anywhere outside the menu to close
the menu without performing an action.

TEE B:48 €3
All Tasks Priority «
[] ! Send status report
[] Buy birthday gift
] call Maria
[] Proof new proposal
Ot  Press and hold to display the pop-up menu.
Create Copy
Delete Task Using the tip of the sylus, tap the
— action you want.
Beam Task...
+— Tap outside the menu to close it (when you
decide not select an option on the menu).
New Tools E!A
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Notifications

Your V38r reminds you in a variety of ways when you have
something to do. For example, if you have set up an
appointment in Calendar, a task with a due date in Tasks, or an
alarm in Clock, you will be notified in any of the following ways:

e A message appears on the screen.
e A sound, which you can specify, is played.
e The notification LED flashes.

To choose reminder types and sounds for your V38r, tap
Settings on the Start menu. On the Personal tab, tap
Sounds & Notifications.

Entering Information

You have several options for entering new information:

e Use the Input Panel to enter typed text, either by using the
soft (on-screen) keyboard or other input methods.

e Write directly on the screen.
e Draw pictures on the screen.

e Speak into the microphone to record a message. For more
information on using the microphone, see the section on
“Recording a Message”.
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Entering Text Using the Input Panel

Use the Input Panel to enter information in any program on
your V38r.

You can either type using the soft (on-screen) keyboard or
write using the Block Recognizer or Letter Recognizer. In any
case, the characters appear as typed text on the screen.

Show/Hide the Input Panel

To show or hide the Input Panel, tap the Input Panel button.

Tap the arrow next to the Input Panel button to see your
choices.

Options...

Block Recognizer
* Keyboard Select an input method.

Letter Recognizer

Transcriber

New Edit Yiew Tools 1, »] Tap to see your choices.

Input Panel button

ViewSonic Rugged Handheld

24



When you use the Input Panel, your V38r anticipates the word
you are typing or writing and displays it above the Input Panel.
When you tap the displayed word, it is inserted into your text at
the insertion point. The more you use your V38r, the more
words it learns to anticipate.

“h ¢ 335 (D

Maonthly mee -

H— Tap here if this is the right word.

|meeting|
1231 [2[3]4[5|6[7[a]o[0]-[=[«
Ta[alwle r]t[y[ulio]p
caPla[s[d[fla[n]i[k[1[:]"]

—

shiftfz [ [c[¥[b[n[m[, [. [/«
culaia 4] [+]1]e]>
New Edit Tools & |E|‘|

NOTE: To change word suggestion options, such as the number
of words suggested at one time, tap Settings on the Start
menu. On the Personal tab, tap Input, then tap the Word
Completion tab.

Block Recognizer

With Block Recognizer, you can use the stylus to input
characters and words.

To type with Block Recognizer:

1 Tap the arrow next to the Input Panel button, and then tap
Block Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that
appears on the screen. For specific instructions on using Block
Recognizer, open Block Recognizer, and then tap the question
mark (?) next to the writing area.
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Soft Keyboard

The Soft Keyboard is an on-screen keyboard displayed at the
bottom of the screen.

To type with the soft keyboard:

1 Tap the arrow next to the Input Panel button, and then tap
Keyboard.

2 On the keyboard that is displayed, tap the keys with your
stylus.

Letter Recognizer

With Letter Recognizer, you can write letters using the stylus
just as you would use a pen on paper.

To type with Letter Recognizer:

1 Tap the arrow next to the Input Panel button, and then tap
Letter Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that
appears on the screen. For specific instructions on using Letter
Recognizer, open Letter Recognizer and then tap the question
mark next to the writing area.

Transcriber

With Transcriber you can write anywhere on the screen using
the stylus just as you would on paper. Unlike Letter Recognizer
and Block Recognizer, you can write a sentence or more of
information; then, you pause and let Transcriber change the
written characters to typed characters.

To type with Transcriber:

1 Tap the arrow next to the Input Panel button, and then tap
Transcriber.

2 Write anywhere on the screen.

For specific instructions on using Transcriber, open Transcriber
and then tap the question mark in the lower-right corner of the
screen.
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Writing on the Screen

In any program that accepts writing—such as the Notes
program and the Notes tab in Calendar, Contacts, and
Tasks—you can use your stylus to write directly on the screen.
Write the way you do on paper. You can edit and format what
you have written and convert the information to text later.

To write on the screen, tap the Pen button to switch from
tapping to writing mode. This action displays lines on the
screen to help you write.

" Rring the
Pocke? +C
vV 3 &r |

New Edit Tools E E|‘

l—Tap the Pen button and use
your stylus like a pen.

Some programs that accept writing may not have the Pen
button. See the documentation for that program to find out
how to switch to writing mode.
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If you want to edit or format writing, you must select it first. To
select writing:

1 Press and hold the stylus next to the text you want to select
until the insertion point appears.

2 Without lifting, drag the stylus across the text you want to
select.

If you write accidentally on the screen, tap Tools, then Undo,
and try again. You can also select text by tapping the Pen
button to deselect it and then dragging the stylus across the
screen.

You can cut, copy, and paste written text in the same way you
work with typed text: press and hold the stylus on the selected
words and then tap an editing command on the pop-up menu,
or tap the command on the Edit menu. To convert writing to
text, tap Recognize on the Tools menu.

If you want to convert only certain words, select them before
tapping Recognize on the Tools menu (or press and hold the
selected words and then tap Recognize on the pop-up menu).
If a word is not recognized, it is left as writing.

& 4939 @ & dé939 @

jriﬂg fhe Bring The
Pocker £C Pocke7r £C

VEIITE | v3s.! I

Cut
Copy
Paste
Clear
Recognize - -
Alternates... 4 -
New Edit Tools [/ = New Edit Tools (=[] =R
| Select the text you want to Your handwriting is
convert and tap Recognize turned into text.

on the Pop-up menu.
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If the conversion is incorrect, you can select different words
from a list of alternates or return to the original writing. To do
so, press and hold the incorrect word (tap one word at a time).
On the pop-up menu, tap Alternates.

A menu with a list of alternate words appears. Tap the word you
want to use, or tap the writing at the top of the menu to return
to the original writing.

£ |Notes % 4¢ 955

-

Tap the word you want
to use.

Or, tap outside the
pop-up window to return
to your original writing.

-

o[n]) [I——TJw«n]u

New Edit Tools || /| =8

Some tips for getting good recognition are listed below:

e Write on the lines and draw descenders below the line.
Write the cross of the “t” and apostrophes below the top
line so that they are not confused with the word above.
Write periods and commas above the line.

For better recognition, use the Tools menu to increase the
zoom level to 300%.

e Write the letters of a word close together and leave big
gaps between words.

e Hyphenated words, foreign words that use special
characters such as accents, and some punctuation cannot
be converted.

o If you add writing to a word to change it (such as changing
a “3” to an "8") after you attempt to recognize the word,
the writing you add will not be included if you attempt to
recognize the writing again.
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Drawing on the Screen

You can draw on the screen in the same way that you write on
the screen. The difference between writing and drawing on the
screen is how you select items and how they can be edited. For
example, selected drawings can be resized, while writing
cannot.

To create a drawing, cross three ruled lines on your first stroke.
A drawing box appears. Drawings that do not cross three ruled
lines will be treated as writing.

———————————————

e P s
-~ Ve
<> [ The drawing box indicates the

boundaries of the drawing.

-

New Edit Tools E |-

You may want to change the zoom level so that you can more
easily work on or view your drawing. Tap Tools, then choose a
zoom level.

If you want to edit or format a drawing, you must select it first.

To select a drawing, press and hold the stylus on the drawing
until the selection handle appears. To select multiple drawings,
deselect the Pen button and then drag to select the drawings
you want.

You can cut, copy, and paste selected drawings by pressing and
holding the selected drawing and then tapping an editing
command on the pop-up menu, or by tapping the command on
the Edit menu. To resize a drawing, make sure the Pen button
is not selected, and then drag a selection handle.
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Recording a Message

In any program where you can write or draw on the screen, you
can also quickly capture thoughts, reminders, and phone
numbers by recording a message. In Calendar, Tasks, and
Contacts, you can include a recording in the Notes tab. In the
Notes program, you can either create a stand-alone recording
or include a recording in a written note. If you want to include
the recording in a note, open the note first. In the Inbox
program, you can add a recording to an email message.

To create a recording:

1 Hold the V38r’s microphone about three inches from your
mouth.

2 Press and hold the record button on the left side of the unit.
If the speaker is not muted, a beep indicates that your V38r
is recording.

3 While holding down the record button, speak into the
microphone.

4 To stop recording, release the record button. Two beeps will
sound. The new recording appears in the note list or as an
embedded icon.

NOTE: You can also make a recording by tapping the Record
button on the Recording toolbar.

To play a recording:

e Tap it in the list or tap its icon in the note.
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@ = Indicates an embedded
=, ] recording.
Business
Proposal
‘ Tap to begin recording.
o[m[) [J——— [« m[a
New Edit Tools ] ] =

! Tap to show or hide the
Recording toolbar.

Recording Formats

Your V38r supports several formats for voice notes. The
formats vary in both the quality of the recording and the size of
the sound file. When selecting a recording format, you should
consider the quality you need as well as how much storage
memory the recording will use on your V38r.

Not all recording formats are compatible with other software or
computers. If you will share your recordings with others or
transfer a recording to your PC, be sure to choose a recording
format that is supported by the software used to play
recordings on the other computer.

To select a recording format:

1 On the Start menu, tap Settings, and then tap the Input
icon.

2 On the Options tab in the Input control panel, select a voice
recording format from the drop-down list.

The list of recording formats on your V38r indicates the sample
rate, whether the format is stereo or mono, and how much
storage memory is required per second of recording. You may
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need to experiment with different sample rates and formats to
determine which format best suits your voice.

Using My Text

When using Inbox, use My Text to quickly insert preset or
frequently used messages into the text entry area. To insert a
message, tap My Text, and then tap a message.

NOTE: After inserting a My Text message, you can add text to
it before you send the message.

To edit a My Text message, on the Tools menu, tap Edit My
Text Messages. Select the message you wish to edit and
make desired changes.
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Chapter 3: Managing Your V38r

This chapter tells you how to effectively manage power and
memory, and how to add/remove programs and back up your
data.

Managing Power

It is important to maintain a continuous power supply to the
V38r to prevent data or files stored in RAM from being
damaged. Your V38r can operate either on external AC power
or internal battery power. Note that you will lose any
information, programs or settings that you have added if the
battery completely runs out of power.

A fully charged battery should provide power for up to 4 hours
of use. The operating time of a fully charged battery depends
on how you are using the V38r. Using some functions, such as
some of the multimedia features or a Secure Digital memory
card, may consume extra battery power.

You should recharge the battery when a warning of low power is
displayed on your V38r, or the V38r will turn off automatically.
You will need to connect the V38r to external AC power for
charging before you can use it again.

See Chapter 1 for information about powering on your V38r.
To check the remaining power:

1 On the Start menu, tap Settings.
2 On the System tab, tap the Power icon.

The remaining power is displayed on a status bar in the Power
control panel.
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Smart Power Management

Power management utilities are supplied with your V38r that
provide you options that help prolong the battery’s operating
time. To access these utilities, do the following:

1 Tap [, then tap Settings.
2 Tap System tab, then tap Advanced Settings.

Under Advanced Settings there are three tabs: System, Smart Battery,
and Power Manager. Descriptions for these options are provided below.

System

This screen provides system information. It does not contain
any control options.

Smart Battery

Option Description

Auto This mode automatically adjusts the CPU speed
. according to the need of the current operation.
(default setting)

Low Performance This mode prolongs the battery life by minimizing the
CPU’s performance.

High Performance This mode enhances battery life by improving the
CPU’s performance.

Superior Performance This mode decreases the battery life, resulting from
maximum CPU performance.

Power Manager

Option Description

You can also select the events that wake up your V38r from Sleep Mode:
NOTE: For each of the three options below the default setting is “checked.”

Application Buttons If this option is checked, you can wake up your V38r by
pressing one of these four application buttons on the
front of your V38r: Note, Calender, Contacts, or

Task.
Record Button If this option is checked, you can wake up your V38r by
pressing the Record button on the V38r.
SD/MMC Card Insertion/ If this option is checked, you can wake up your V38r
Removal by inserting or removing an SD card.
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Power-Saving Tips

Follow these suggestions to maximize the battery’s operating
time:

e Turn off the backlight. Press and hold the power button
to turn off the backlight, or use the Backlight control panel
to set the backlight to turn off automatically after a short
period of inactivity.

e Suspend frequently. Use the Power control panel to
shorten the length of continuous idle time before your V38r
auto-suspends. Press the power button to turn off your
V38r when it is not in use, even for a short time.

e Always use AC power when connecting your V38r to
your PC. Note that your V38r will not auto-suspend while it
is connected.

e Turn off sounds. Use the Sounds & Notifications control
panel to turn off all but the most necessary system sounds.

e Avoid using memory card accessories while on
battery power. Some memory cards use considerable
power and will quickly drain your battery.

e Do not “listen” for infrared transfers. Although you can
set your Rugged Handheld to constantly monitor the IR
port for files sent from other devices, doing so will quickly
drain your batteries.

Managing Memory

Your V38r uses two kinds of memory: storage and program
memory (RAM), and optional memory cards.

Storage and Program Memory

RAM (Random Access Memory) on your V38r is shared between
storage memory and program memory. “Storage memory” is
used to store the data you create and additional programs you
install. "Program memory” is used to run programs on your
V38r. Your V38r automatically manages the allocation between
storage and program memory. However, in some situations,
such as when the memory is running out, your V38r may not be
able to automatically adjust the allocation.
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Memory Cards

Memory cards are small, removable flash storage cards that
enable you to expand the memory of your V38r. You can use
memory cards for backup storage, archives, or to transfer large
files to other devices. Your V38r supports Secure Digital
memory cards. Memory cards can be purchased from a variety
of third-party vendors.
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SD Memory Capabilities

Your V38r has an SD card slot which accepts an SD (Secure Digital)
memory card. You can purchase an SD card to expand the memory
capacity and capabilities of your V38r.

To insert an SD memory card:
1 Slide the end of the card with the chipped corner into the SD slot on the
side of the V38r.
2 Push the card into the slot until it clicks into place.
3 To remove an SD memory card, press the card. When the card pops out
slightly, you can pull it out.

SDRAM Memory Allocation
The V38r has 64 MB of SDRAM memory:

e For the USA and European models: 27.5 MB is used by the
Rugged Handheld 2003 Operating System, applications,
and drivers.

e For the Asian models: 35.5 MB is used by the Rugged
Handheld 2003 Operating System, applications, and
drivers.

e The remaining memory is available for user applications
and file storage: 36.5MB for the USA and Europe V38r
models and 28.5MB for the Asian V38r models.

Memory Map for 64MB SDRAM:

Description USA and European Asian Models
Models

Flash ROM Image allocated for 24.0 MB 32.0 MB
Rugged Handheld 2003 Operating
System and applications

Drivers 3.5 MB 3.5 MB
Available for user applications and | 36.5 MB 28.5 MB
file storage

Total Memory 64.0 MB 64.0 MB

NOTE: The USA and Europe V38r models have an additional 36
MB of Flash ROM memory available for file storage called "My
Flash Disk."
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The Asian V38r models have an additional 31 MB of Flash ROM
memory available for file storage. This additional Flash ROM is
smaller because the Asian operating systems require more
space.

Antenna Signal Properties

Your V38r can use a wireless radio signal standard called the
802.11b/g standard to communicate with a local 802.11b/g
standard network connected to a modem. The quality of your
radio connection signal can be weakened by excessive distance
and by intervening materials such as walls and furnishings. If
the wireless connection seems to work intermittently, check the
quality of your wireless connection.

Finding and Organizing Information

The Find feature on your V38r helps you quickly locate
information.

To find a file, on the Start menu, tap Find. Enter the text you
want to find, select a data type, and then tap Go to start the
search.

NOTE: To quickly find information that is taking up storage
space on your V38r, select Larger than 64KB under Type.
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You can also use the File Exp

lorer to find files on your V38r and

to organize these files into folders. On the Start menu, tap
Programs, and then tap File Explorer.

Tap to change folders.

File Explorer % o< 12:04 6

@ My Device « Name » —— Select the sort order for the list.

£ ConnMagr

Tap the folder name to open it.

My Documents
(@] My Flash Disk
) profiles
[C)Program Files
(@] Storage Card
3 Temp

3 utility

=) Windows

Wiew All Files

Paste
Paste Shortcut

Press and hold to create a new folder.

MNew Folder

edit op...[<[@]M 3 B
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Customizing Your V38r

You can customize the settings of the V38r to your own
preferences.

Tap Start, then tap Settings. You can tap any of the icons on
the Personal, System, or Connections tabs to customize
your V38r. The customization options are as follows:

Options Description

PERSONAL

Buttons Assigns your favorite programs to the program buttons,
and sets the repeat rate of the scroll dial.

Input Sets the settings related to Block Recognizer, soft
keyboard, Letter Recognizer and Transcriber input
methods.

Menus Selects the items that appear on the Start menu and the
New menu on the Today screen.

Owner Saves your personal information.

Information

Password Sets the password to your V38r to protect the stored
data.

Sounds & Sets the conditions and types of the sounds, system

Notifications

volume, and ways of notifications.

Today Sets the items that appear on the Today screen.
SYSTEM About Shows information about the version of the operating

system, the name of the Rugged Handheld, and
copyrights.

Backlight Adjusts the backlight of the display.

Clock Sets the current time and alarm.

Memory Adjusts the allocation of data and program storage.

Power Shows the remaining battery and external AC power,
and set the time for the V38r to turn off automatically.

Regional Sets the region of your location, and formats for number,

Settings currency, time and date.

Remove Removes programs pre-installed in RAM.

Programs

Screen Realigns the touch screen for accurate taps.
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Setting a Password

A password can safeguard your V38r against unauthorized use.
To set your password:

1 Tap Start, tap Settings, then tap the Password icon on the
Password tab.

2 Tap the digits or characters to set your password. You can set
a four-digit password, or a long password containing a
combination of at least seven characters, digits or
punctuation.

3 You can set the time for the V38r to prompt for a password
after idling.

4 Tap OK.

Adding or Removing Programs
Adding Programs

You can add even more functionality to your V38r by installing
additional software and programs. A wide variety of software is
available for Windows Powered Rugged Handhelds, ranging
from custom business applications and system utilities to
games and entertainment. Some programs are available from
software vendors or on the Web.

Install only programs designed specifically to run on a Rugged
Handheld personal digital assistant and/or a Windows Powered
Rugged Handheld. You cannot run programs designed for
Windows on your V38r. In addition, you may need a version of
the program designed specifically for the X-Scale processor
used by your V38r.

Install software to your V38r by first loading the installation
files onto your PC. Use ActiveSync on your PC to transfer and
install programs to the storage memory (RAM) in your V38r.
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Removing Programs

To free storage memory on your V38r, you can remove
programs you no longer use. Only programs that are stored in
RAM can be removed.

Programs pre-installed in Flash ROM cannot be removed;
however, these programs do not use storage memory.

To remove a program:

1 On the Start menu, tap Settings.
2 On the System tab, tap Remove Programs.

3 Select the program in the list, and then tap Remove.

NOTE: If the program does not appear in the list of installed
programs, use File Explorer on your V38r. Locate the
program, press and hold the stylus on the program, and then
tap Delete on the pop-up menu.

Backing Up Data

To prevent loss of data, you should back up your V38r
frequently. Your V38r comes with two programs for backing up
data:

¢ Microsoft ActiveSync. ActiveSync enables you to back
up data to your PC. You can back up all data on your V38r,
or only your PIM databases (Calendar, Contacts, and
Tasks). You can set ActiveSync to back up automatically
each time you connect, or you can back up manually,
whenever you choose. For more information, see
ActiveSync Help on your PC.

e Backup enables you to back up all data stored in the
internal (RAM) memory on your V38r. You can save the
backup file on an optional Secure Digital memory card.
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Using Backup

Backup gives you added flexibility in backing up your valuable
data. With Backup, you can back up all data in RAM. You can
save the backup file to an optional SD memory card, so you can
safeguard your data even while you are traveling or away from
your PC.

NOTE: An internal storage device called "My Flash Disk” is
included. When using Backup, you can choose this disk as your
target backup device.

Backing up data using Backup

1
2

3

Close all running applications and insert a memory card.
Disconnect your V38r from your PC.

On the Start menu on your V38r, tap Programs and then
tap the Backup icon.

Tap Backup, then tap Next.

Tap your preference of storage media for backing up your
data, then tap Next.

Tap the item you want to back up, then tap Next.
Tap Backup, then tap Yes to start the backup process.

Remove the memory card after the backup is complete.

CAUTION:

o Never delete the backup file in the memory card. If
the backup file is deleted, the backup data will be
lost and cannot be restored.

e When you use the backup file to restore information,
information on your V38r is replaced with the
information stored in the backup file. If you have
created files on your V38r since the last backup and
do not want to delete these files during the restore
process, move the files from your V38r to your PC--or
to an optional memory card--before restoring the
information.
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Restoring data using Backup

1

Close all running applications and insert a memory card with
the backup data.

Disconnect your V38r from your PC.

On the Start menu tap Programs, then tap the Backup
icon.

Tap Restore, then tap Yes.

Tap your preference of storage media for restoring your data,
then tap Next.

Tap the item you want to restore, then tap Next.
Tap Restore, then tap Yes to start the restore process.

Remove the memory card after the restore process is
complete, and reset your V38r.

IMPORTANT: When you restore data, your V38r must have
the same regional settings that it had when you completed the
backup; otherwise, you will not be able to restore the files. To
change regional settings, on the Start menu, tap Settings,
and then tap the Regional Settings icon on the System tab.
Select your region from the drop-down list.
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Chapter 4: Microsoft ActiveSync

This chapter tells you what the Microsoft ActiveSync program
is and what you need to do to use it.

Using Microsoft ActiveSync

NOTE: ActiveSync is already installed on your V38r. You need
to install ActiveSync on your PC. (For information on installing
ActiveSync, see Step 5 of the Quick Start procedure in Chapter
1, “Installing Microsoft ActiveSync.”)

Microsoft ActiveSync allows you to synchronize the
information on your PC with information on your V38r.
Synchronization compares the data on the two sides and
updates both computers with the most recent information. For
example, you can:

e Keep your Pocket Outlook Contacts, Calendar, and Tasks
databases up-to date by synchronizing your V38r with
Microsoft Outlook data on your PC.

IMPORTANT: Outlook must be installed on your PC in
order to synchronize your email data.

e Synchronize email messages in your V38r Inbox with email
messages in Microsoft Outlook on your PC.

e Synchronize Microsoft Word and Microsoft Excel files
between your V38r and PC. Your files will be automatically
converted to the correct format.

With ActiveSync, you can also:

e Back up and restore your V38r data.

e Copy (rather than synchronize) files between your V38r
and PC.

e Add and remove programs on your V38r.
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Synchronizing Data

Once you have created a synchronization partnership and
completed the first synchronization, you can initiate
synchronization from your V38r. Follow this procedure:

1 Connect your V38r to your PC. (See “Connecting to Your PC”
in this chapter.)

2 On your V38r, tap [, and then tap ActiveSync.

3 Tap & to begin synchronization.

.::_E;.‘:;«'" ActiveSync o} o< 650 @

@
Connected View connection status.

Tap to connect and synchronize.
‘ ‘ Tap to stop synchronization.

@ Sync a Stop

Synchronize with Windows PC
Last Svnc: 51403 6:50 P

— View synchronization status.

Tools E|*

By default, ActiveSync does not automatically synchronize all
types of information. Use ActiveSync options to turn
synchronization on and off for specific information types. You
can:

e Control when synchronization occurs by selecting a
synchronization mode. For example, you can synchronize
continually while the V38r is connected or only when you
choose the synchronize command.

e Select which information types are synchronized and
control how much data is synchronized. For example, you
can choose how many weeks of past appointments you
want synchronized.
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For information on setting ActiveSync options and using
ActiveSync on your PC, see ActiveSync Help on the PC. For
information on using ActiveSync in your V38r, see ActiveSync
Help on the V38r.

Connecting to Your PC

CAUTION: Do not shut down or restart your PC while
your V38r is connected. Turn off your V38r or disconnect
the USB cable before you shut down your PC.

Connecting by USB Cable

CAUTION: Before you connect your V38r to the USB
synchronization cable, be sure of the following: your PC
is on, you have installed ActiveSync on your PC, and
ActiveSync is configured to allow a USB connection.

For connection instructions, see the section “Installing Microsoft
ActiveSync” in this guide.
Connecting by Infrared

You can use the IR port to synchronize data with your PC, in
place of using the cable.

IR ports can be found on many notebook computers; however,
on a PC, you may need to install and configure an IR port. To
install the port, follow the manufacturer’s instructions.

For complete instructions on connecting to your PC by infrared,
refer to ActiveSync Help on your PC.
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Chapter 5: Pocket Outlook

This chapter introduces you to the basics of Microsoft Pocket
Outlook, including Calendar, Contacts, Tasks, Notes and Inbox.

Scheduling Appointments/Meetings

Use Calendar to schedule appointments, including meetings
and other events.

You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views
by using the View menu.

;’ﬁ” Calendar 3, 4 7:25 9

Aug06,00 EMTWTFS B 5]

Working at home

Lunch w/ Adam Tap to display or edit the
12:00p-1:00p (Corner Cafe) appointment details.

| Tap to go to Today.

Status Meeting
3:00p-4:00p

R EEEEEEER
I

—Tap to create a new appointment.

NOTE: You can customize the Calendar display (for example,
change the first day of the week), by tapping Options on the
Tools menu.
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Creating an Appointment

1 In Day or Week view, tap the desired date and time for the
appointment.

2 Tap New.

Tap to return to the calendar (the
appointment is saved automatically).

& 852 @

f Tap to choose from predefined text.

Subject:
Location: ¥1— Tap to choose from previously
Starts: B/6/00 12:00 PM = entered locations.
Ends: 8/6/00 1:00 PM Y1 Tap to select a time.

Type: MNormat Tap to select a date.
Occurs: Once

Reminder: Rermind me

15 minute(s)
Cateqories; MNO cateqories...
Appaintment | Nokes I Notes is a good place for
123(1]2[3]4[s5]6]7[8]9]o]-[=[« maps and directions.

Tabla[wle|r|t|y[ulilo|p[[]]
CcaPla[s[d]flaln[i[k[1][:]"]

shiftfz[x[c[v[b[n[m][,[.[/]+
claa]* [\ ] [+[t]<]>
et Bl

3 When using the Input panel, tap first to select the field, and
then enter a description and a location.

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the
Input panel to see all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or
create a recording. For more information on creating notes,
see “Notes: Capturing Thoughts and Ideas” later in this
chapter.

7 Tap OK to return to Calendar.

NOTE: If you select Remind me in an appointment, your V38r will
remind you according to the options set in the Sounds &
Notifications control panel.
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Using the Summary Screen

When you tap an appointment in Calendar, a summary screen
displays. To change the appointment, tap Edit.

ﬁ Calendar % £ 9:11 @

Lunch w/ Adam VA

12:00p-1:00p Sun, 8/6/2000 View appointment details.
Corner Cafe

Remember portfolio. —t— View.

Edit Tools E|A
1

Tap to change appointment.

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook
or Pocket Outlook. The meeting notice will be created
automatically and sent either when you synchronize Inbox or
when you connect to your email server. Indicate how you want
meeting requests sent by tapping Tools and then Options. If
you send and receive email messages through ActiveSync,
select ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 In the appointment details, hide the Input panel, and then
tap Attendees.

3 From the list of email addresses in Contacts, select the
meeting attendees.

The meeting notice is created automatically and placed in the
Outbox folder. For more information on sending and receiving
meeting requests, see Calendar Help and Inbox Help on your V38r.
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Managing Contacts

Contacts maintains a list of your friends and colleagues so that
you can easily find the information you are looking for, whether
you are at home or on the road. Using the IR port on the V38,
you can quickly share Contacts information with users of
Rugged Handhelds and other mobile devices.

Select the category of contacts you
want to display in the list.

e 0 i b X

\All Contacts «

#zb| cde| foh| ik | mn{opg| rst junw| vz

Barr, Adam {206) 555-1212 w —
Bready, Richard rich@proseware... e

Create Copy
Delete Contact

Send E-mail to Contact...
Beam Contact...

INew Yiew Tools El-

-|JBP to create a new record.

Tap and enter part of a name
to quickly find it in the list.

Tap to see additional phone
numbers and e-mail addresses.
Tap to display or edit the
contact details.

Press and hold to display a
pop-up menu of actions.

NOTE: To change the way information is displayed in the list,

tap Tools then tap Options.
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1 Tap New.

Tap to return to the contact
list (the contact is saved
automatically).

Mame:

Job title:
Department:

Companty:

‘Work kel:

[»

Whork Fax:
‘Work addr: b
E-mail:
Mobile tel:
Detais | Notes$
123[1[2[3[4][5]6]7][8]9]0]-

4]

— Scroll to see more fields.

Notes is a good place for
|« maps and directions.

Tab[a[wle[r[t[y[uli[e]p[[]]
caPlals[d[f[a[hfilk[I];]"]
shift| z [x [c|v[b[n|m]|,|.[/]

culaa]* [\] [4[t]e]
Edit =R

2 Using the Input panel, enter a name and other contact
information. You will need to scroll down to see all available
fields.

3 To assign the contact to a category, scroll to and tap
Categories then select a category from the list. In the
contact list, you can display contacts by category.

4 To add notes, tap the Notes tab. You can enter text, draw, or
create a recording. For more information on creating notes,
see “Notes: Capturing Thoughts and Ideas” later in this
chapter.

5 Tap OK to return to the contact list.
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Finding a Contact
There are four ways to find a contact:

e On the Start menu, tap Find, enter the contact name,
select Contacts for the type, and then tap Go.

¢ In the contact list, enter a contact name in the box under
the Navigation bar.

To show all contacts again, clear text from the box or tap the
button to the right of the box.

e In the contact list, tap the category list (labeled All
Contacts by default) then select the type of contact that
you want displayed. To show all contacts again, select All
Contacts. To view a contact not assigned to a category,

select None.

e To view the names of companies your contacts work for, in
the contact list, tap View then tap By Company. The
number of contacts that work for that company will be
displayed to the right of the company name.
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Using the Summary Screen

When you tap a contact in the contact list, a summary screen
displays. To change the contact information, tap Edit.

f.g Contacts

% 4¢9:.07 P

Adam Gabor
Programmer

R&D

Inspired Technologies

+— View contact details.

(206) 555-1212 Work tel
111 First St. Work addr
summary | Notes
Edit Tools E|A

Tap to view notes.

1
|— Tap to change contact information.
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Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do.
Select the category of tasks you want to

display in the list.

q
WL

All Tasks

Priority v

[] ¢ Send status report

[] Buy birthday gift
[] callMaria
[] Proof new proposal

Create Copy

M | Srhadule massage —

Delete Task

Beam Task...

New Tools
1

Tap to create a new task.

Select the sort order of the list.

! Indicates high priority.

Tap to display or edit the task details.

Press and hold to display a
pop-up menu of actions.
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Creating a Task
1 Tap New.

Tap to return to the task list
(the task is saved automatically).

Subject: — Tap to choose from
Pricrity: Normal predefined subjects.
Status: Not Completed
Starts: MNone

Due: MNone
Occurs: Once

Reminder: Mone

Cateqories: MNO cateqaries...

Task | Notes Notes is a good place for
123/1[2(3]4[5|6|7[8[0]0]-[=|® maps and drawings.

Tabla|wle|r[t|y[ulio[p|[]]
caPlafs[d[fla[h]ifk[I]:]"]

shift[z[x[c[v[b[n]m].[.[/]+
culat] - [\ ] [+]t]<]~
ea Bl

2 Using the Input panel, enter a description.

3 You can enter a start date and due date, or enter other
information by first tapping the field. If the Input panel is
open, you will need to hide it to see all available fields.

4 To assign the task to a category, tap Categories, then select
a category from the list. In the task list, you can display tasks
by category.

5 To add notes, tap the Notes tab. You can enter text, draw, or
create a recording. For more information on creating notes,
see “Notes: Capturing Thoughts and Ideas” later in this
chapter.

6 Tap OK to return to the task list.
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Using the Summary Screen

When you tap a task in the task list, a summary screen
displays. To change the task, tap Edit.

Send status report H
—+— View task details.
Starts: 8/18/2000
mine B EY2000 al— Tap to show or hide additional
Send to the whole team using the new summary information.
format,
—t+— View notes.
Edit Tools B3

l— Tap to change task.
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Notes: Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and
phone numbers with Notes. You can create a written note or a
recording. You can also include a recording in a note. If a note
is already open when you create the recording, it will be
included in the note as an icon. If the note list is displayed, the
recording will be created as a stand-alone recording.

@ Notes & 4<855
)l Folders + Name Tap to change the sort order of the list.
_|Business1 B:54a 424b

(_Joutlook Motes1  @&:54a 428b
_|Personall 8:54 a 424b

Create Copy Tap to change open a note or play a recording.
Delete .
Pl Press and hold to display a pop-up

menu of actions.

Send via E-mail...
Beam File...

Rename,/Move...

I Tap to record.
o[m)) [[—— | m]u

N?nTools: =]
|

Tap to create a new item.

— Tap to show or hide the Recording toolbar.

Creating a Note
1 Tap New.

2 Create your note by writing, drawing, typing, or recording.
For more information about using the Input panel, writing
and drawing on the screen, and creating recordings, see the
section on “Entering Information” in this guide.

ViewSonic Pocket PC 59



Inbox: Sending and Receiving Email

Use the Inbox to send and receive e-mail messages with
Microsoft Outlook on your PC.

Synchronizing Email Messages

Email messages can be synchronized as part of the general
synchronization process. To do this, you need to enable Inbox
synchronization in ActiveSync. For information on enabling
Inbox synchronization, see ActiveSync Help on the PC.

During synchronization:

e Messages are copied from the mail folders of Exchange or
Outlook on your PC to the ActiveSync folder in Inbox on

your V38r.

e Email messages in the Outbox folder on your V38r are
transferred to Exchange or Outlook, and then sent from
those programs.

e Email messages in subfolders must be selected in
ActiveSync on your PC in order to be transferred.
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Using the Message List

Messages you receive are displayed in the message list. By
default, the most recently received messages are displayed first

in the list.

Select the Internet Service Provider and
the folder you want to display.

@& Robert Brown 8145PM

RE: Today's Meeting

@) Jay Adams Mark as Unread
RE:Pleaser{  Move To...

&) Andrew Dixg

Status Repol

 d¢205 €3

Received Date v |

ad

Mark for Downlo:

16K N

— Select the sort order for messages.
I Tap to open a message.

Bradley Becl
@ RE: Lu};ch Reply
& Stuart Muns Reply all

PocketPC Forward
(@ Linda Mitchel

Reminder Delete

@) Jeff Smith FTHSPIT iy
RE: Working late
Adam Barr 7:15PM 1K
Don't Forget

|

Inbox: ActiveSync 11 Items.

New Tools Services [i]

Press and hold to display a pop-
up menu of actions.

[=]8

Tap to connect, and to send and receive e-mail.

Tap to connect to the selected Internet
Service Provider.
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When you receive a message, tap it to open it. Unread
messages are displayed in bold.

— Tap to return to the message list.

From: Robert Brown
Subject: RE: Today's Meeting
Sent: 4/23/01 8:45:47 AM

Just a reminder to bring your individual
schedules for the next 2 quarters with
you. We will be discussing projects and
timelines.

Tharks,
Bob

| Tap to delete this message.
New Edit =} E} @* 9 =8

=

Tap to view the previous or next message.
Tap to reply to or forward this message.

IMPORTANT: When you synchronize with your PC, by default,
you will receive messages from the last three days only, the
first 100 lines of each new message, and file attachments of

less than 100 KB in size. The original messages remain on your
PC.
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To compose a message, do the following:
1 Tap New.

2 In the To field, enter an email of one or more recipients,
separating them with a semicolon, or select a name from the
contact list by tapping the Address Book button. All email
addresses entered in the email fields in Contacts appear in
the Address Book.

Tap to send the message.

& 219 D

«

— Tap to show or hide the complete header.

New Edit My Text [=] = E|‘

Tap to show or hide the recording toolbar.
Tap to display the Address Book.
Tap to insert common (frequently used) messages.

3 Compose your message. To enter preset or frequently used
messages, tap My Text and select a message.

4 Tap Send when you have finished the message. If you are
working offline, the message is moved to the Outbox folder
and is sent the next time you connect. The message is placed
in the Outbox folder on your device.
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Managing Email Messages and Folders

By default, messages are displayed in one of five folders for
each service you have created: Inbox, Deleted Items, Drafts,
Outbox, and Sent Items. The Deleted Items folder contains
messages that were deleted from the V38r.

The behavior of the Deleted and Sent Items folders depends on
the options you have chosen. In the message list, tap Tools
then tap Options. On the Message tab, select your options.

If you want to organize messages into additional sub-folders,
tap Tools, then tap Manage Folders to create new folders. To
move a message to another folder, in the message list, press
and hold the message then tap Move on the pop-up menu.
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Chapter 6: Companion Programs

This chapter tells you about Microsoft Pocket Word and
Microsoft Pocket Excel.

Pocket Word

Microsoft Pocket Word works with Microsoft Word on your PC to
give you easy access to copies of your documents. You can
create new documents on your V38r or you can copy
documents from your PC.

IMPORTANT: Synchronize documents between your PC and
your V38r regularly so that you have the most up-to-date
content in both locations.

Using Pocket Word

1 On the Start, tap Programs and then tap the Pocket Word
icon.

2 Type the name of a document in the file list or tap New to
open a blank document.

NOTE: To open a template rather than a blank document,
select a template for new documents. Tap on the Tools menu,
tap Options, then browse to select the default template. When
you tap New, the template appears with appropriate text and
formatting already provided.

You can open only one document at a time; when you open a
second document, you will be asked to save the first. You can
save a document you create or edit in a variety of formats,
including Pocket Word (.psw), Rich Text Format (.rtf), and Plain
Text (.txt).

You can enter information in Pocket Word in four modes:
writing, drawing, typing, and recording. Use the View menu to
switch between modes. Each mode has its own toolbar which
you can show or hide by tapping the Show/Hide Toolbar
button on the Command bar.

e Typing Mode. Use the Input panel to enter typed text into
the document with the soft keyboard. For more information
on entering typed text, see “Entering Information” in
Chapter 2.
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e Writing Mode. In writing mode, use your stylus to write
directly on the screen. Ruled lines are displayed as a guide,
and the zoom magnification is greater than in typing mode
to allow you to write more easily. For more information on
writing and selecting writing, see “Entering Information” in
Chapter 2.

NOTE: Written words are converted to graphics (metafiles) when a Pocket
Word document is converted to a Word document on your PC.

e Drawing mode. In drawing mode, use your stylus to draw
on the screen. Gridlines appear as a guide. When you lift
your stylus off the screen after the first stroke, you will see
a drawing box indicating the boundaries of the drawing.
Every subsequent stroke within or touching the drawing
box becomes part of the drawing. For more information on
drawing and selecting drawings, see “Entering Information”
in Chapter 2.

¢ Recording mode. Use recording mode to embed a
recording into your document. Recordings are saved as
WAV files. For more information on recording, see “Entering
Information” in Chapter 2.

Tips for Working in Pocket Word

¢ You can change the zoom magnification by tapping View
and then taping Zoom. Then select the percentage you
want. Select a higher percentage to enter text and a lower
one to see more of your document.

e If you are opening a Word document created on a PC,
select Wrap to Window on the View menu so that you
can see the entire document.

Pocket Excel

Microsoft Pocket Excel works with Microsoft Excel on your PC to
give you easy access to copies of your workbooks. You can
create new workbooks in your V38r, or you can copy workbooks
from your PC to your V38r. Synchronize workbooks between
your PC and your V38r so that you have the most up-to-date
content in both locations. Pocket Excel provides fundamental
spreadsheet tools, such as formulas, functions, sorting, and
filtering, which enable you to create simple workbooks, such as
expense reports and mileage logs.
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1 On the Start menu, tap Programs and then tap the Pocket
Excel icon.

2 Tap the name of a workbook in the file list or tap New to
open a blank workbook.

You can open only one workbook at a time; when you open a
second workbook, you will be asked to save the first. You can
save a workbook you have created or edit in a variety of
formats, including Pocket Excel (.pxl) and Excel (.xls).

Tips for Working in Pocket Excel

View in full-screen mode to see as much of your worksheet
as possible. Tap View and then tap Full Screen. To exit
full-screen mode, tap Restore.

If your workbook contains sensitive information, you can
protect it with a password. To do so, open the workbook,
tap Edit, and then tap Password.

Show or hide window elements. Tap View, then tap the
elements you want to show or hide.

Freeze panes on a worksheet. First, select the cell where
you want to freeze panes. Tap View and then tap Freeze
Panes. You might want to freeze the top and furthest left
panes in a worksheet to keep row and column labels visible
as you scroll through a sheet.

Split panes to view different areas of a large worksheet.
Tap View and then tap Split. Then drag the split bar to
where you want it. To remove the split, tap View and then
tap Remove Split.

Show and hide rows and columns. To hide a row or column,
select a cell in the row or column you want to hide, tap
Format, tap Column, then tap Hide. To show a hidden
row or column, tap Tools, tap Go To, then type a
reference that is in the hidden row or column. Tap Format,
then tap Row or Column, then tap Unhide.
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Windows Media Player for Rugged
Handheld

Use Microsoft Windows Media Player for V38r to play digital
audio and video files that are stored on your V38r or on a

network. To switch to Windows Media Player for V38r, tap &
and tap Windows Media.

Tap to display the WindowsMedia.com
website.

indows Media 4-'?;‘ < 4:48 9

m " To Windows Media - 64 kbps

Windows
Media Player

Tap to adjust the playback progress
1 ReadyiTep Rl 0:00 of a selected file.

|

e e =

)P WU ® o

Pldylist Tools E|A Tap to adjust volume.

Tap to mute (temporarily silence) the audio.

Tap to skip to the next file.

Tap to play a previous file.

Tap to stop.
Tap to play or pause.

Use Microsoft Windows Media Player on your PC to copy digital
audio and video files to your V38r. You can play Windows Media
and MP3 files on your V38r.

For more information about using Windows Media Player,
tap &, then tap Help.
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Microsoft Reader

Use Microsoft Reader to read eBooks on your V38r. Download
books to your PC from your favorite eBook Web site. Use
ActiveSync to copy the book files to your activated V38r. The
books appear in the Reader Library, where you can tap them in
the list to open them.

NOTE: Before you can use Microsoft Reader, you must activate
it from the Microsoft activation site (http://das.microsoft.com/
activate). Follow the directions given at the Microsoft site.

Each book consists of a cover page, an optional table of
contents, and the pages of the book. You can:

e Page through the book by using the scroll dial on your V38r
or by tapping the page number on each page.

¢ Annotate the book with highlighting, bookmarks, notes,
and drawings.

e Search for text or look up definitions for words.

The Guidebook contains all the information you need to use the
software. To open the Guidebook, tap Help on the Reader
command bar. Or, on a book page, press and hold on the book
title, and then tap Help on the pop-up menu.

To switch to Microsoft Reader, tap i, tap Programs, then tap
Microsoft Reader.

Getting Books onto Your V38r

You can download book files from the Web. Just visit your
favorite eBook retailer and follow the instructions to download
the book files.

Sample books and a dictionary are also included in the
MSReader folder on the Companion CD.

Use ActiveSync to download the files from your PC to your
activated V38r as described in the Read Me file in the MSReader
folder.
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Using the Library

The Library is your Reader home page. The home page displays
a list of all books stored on your V38r or storage card.

To open the Library:

¢ On the Reader command bar, tap Library.
e On a book page, tap the book title, and tap Library, on the

pop-up menu.

To open a book, tap its title in the Library list.

Tap to select
a sort order.

Tap to specify the
books you want to
display in the list.

Tap here to navigate
to other parts of the
Reader.

Library

The Ghost Writer

The Hundred Secret Senses
Outlander

Suger Plum Dead

Ancther Werld

Winter of the Wolf Moon
The Last Precinct

On Writing

Passage to Juneau

Of Love and Other Demons

Stranger in a Strange Land

The Best American Short Stories

Tap to scroll
through the Library
list.

| Taptoopena
book.
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Reading a Book

Each book consists of a cover page, an optional table of
contents, and the pages of the book. Navigation options are
listed in the bottom portion of the cover page.

The first time you open a book, you will probably want to go to
the first page or to the table of contents, if there is one.

Subsequently, whenever you open the book, you automatically
go to the last page read.

In addition to the text, each book page includes a page number

and book title.

Tap to select a
navigation option.

I+ The Call of the Wild

were booming the find, thousands

rushing into the
Add Bookmark

of men
Northland. Th
dogs, and the
were heavy d
muscles by whiq
coats to prote|
frost.

Buck lived
the sun-kissed
It stood back from the road, half
hidden among the trees, through
which glimpses could be caught
of the wide cool veranda that ran

Add Highlight
Add Note
Add Drawing
Find...

Copy Text

dlita “iara vdaiigy.

15)»

Drag to select text
and then tap an
option.

Tap arrows to turn
the page, or press
and hold page # to
bring up page title.

You can also page through a book by using the scroll dial on

your V38r.
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Using Reader Features

Reading a book electronically gives you several options not
available with paper books. These options are available from
any book page.

Select text by dragging across the text on the page. Then, tap
an option on the pop-up menu, as described here.

e Search for Text. Find text in a book by tapping Find on
the pop-up menu. Enter the word you want to search for,
and tap the desired Find option. Reader highlights found
text on the page. To close Find, tap outside the box. To
return to your original page, tap the title, then tap Return
on the pop-up menu.

e Copy Text. You can copy text from books that support this
feature into any program that accepts text. On a book
page, select the text you want to copy. Then, tap Copy
Text on the pop-up menu. The text can be pasted into the
program of your choice.

e Bookmarks. When you add a bookmark to a book, a color-
coded bookmark icon appears in the right margin. You can
add multiple bookmarks to a book. Then, from anywhere in
the book, tap the bookmark icon to go to the bookmarked
page.

o Highlights. When you highlight text, it appears with a
colored background.

¢ Notes. When you attach a note to text, you enter the text
in a note pad that appears on top of the book page. A Note
icon displays in the left margin. To show or hide the note,
tap the icon.

e Drawings. When you add a drawing, a Drawing icon
appears in the bottom-left corner of the page and drawing
tools appear across the bottom of the page. Draw by
dragging your stylus.

NOTE: To see a list of a book’s annotations, including
bookmarks, highlights, text notes, and drawings, tap
Annotations Index on the book’s cover page. You can tap an
entry in the list to go to the annotated page.
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Removing a Book

When you finish reading a book, you can delete it to conserve
space on your V38r. If a copy of the book is stored on your PC,
you can download it again at any time.

To remove a book from your V38r, press and hold the title in the
Library list, and then tap Delete on the pop-up menu.

Other Programs

The following programs are permanently installed in your V38r:

Program How to Access the Program

Infrared On the Start menu, tap Programs and then tap

Receiver the Infrared Receive icon. Infrared Receive
establishes the connection between your V38r
and the IR device.

Terminal On the Start menu, tap Programs and then tap

Services the Terminal Services icon. Terminal Services
allows you to access the programs and
documents in a Windows NT server type PC that
is running Terminal Services.

Backup To determine if your company has registered

your device with the V38r web service and has
any software download ready for you, you can
run the RDMUpdate.exe file on your V38r. On the
Start menu, tap Programs and then tap the
Backup icon. Backup enables you to back up all
data stored in the internal (RAM) memory on
your V38r. For more information, see section
“Backing up Data” in this guide.
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Chapter 7: Pocket Internet
Explorer

This chapter tells you about Microsoft Pocket Internet Explorer,
Mobile Favorites Folder and AvantGo Channels.

Using Pocket Internet Explorer

Use Microsoft Pocket Internet Explorer to view Web pages by
doing the following:

e During synchronization with your PC, download your
favorite links and mobile favorites that are stored in the
Mobile Favorites subfolder in Internet Explorer on the PC.

To start Pocket Internet Explorer:

e On the Start menu, tap Internet Explorer. The Pocket
Internet Explorer home page:

‘.%.;'j" Internet Explorer  «3 4% 4:51 9
file: { fwindowst default, htm -| @

ia Y Microsoft®
# Pocket Internet Explorer

Welcome to Pocket Internet
Explorer, Mot onling yet? Find out
hiow to get connected and save
offine content.
Carrier

6a8 viewSonic
PocketPC.com

view Tools ¢ &) &3 5% E|‘

Favorites button
L Home button
L Refresh button
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Viewing Mobile Favorites and Channels

1 Tap the Favorites button to display your list of favorites.
2 In the list, tap the page you want to view.

.i(?;' I|Internet Explorer  +% #{£ 4:51
] 4

Favorites

9 Mobile Favorites — | Tap the Favorite you want to view.

l‘b AvantGo Channels
¥ MSN Mabile

Paocket PC Web Guide
(¥} Pocket PC.com

----- {B WindowsMedia.com

COpen [ AddfDelete | ——— [ Tap to add or delete a
=] folder or Favorite link.

You will see the page that was downloaded the last time you
synchronized with your PC. If the page is not on your V38r, it
will be dimmed in the Favorites list. You will need to
synchronize with your PC again to download the page to your
V38r, or connect to the Internet to view the page.

Browsing the Internet
To connect and start browsing, do one of the following:

e Tap the Favorites button, and then tap the favorite you
want to view.

e Tap View, and then tap Address Bar. In the address bar

that appears at the top of the screen, enter the Web

address you want to visit and then tap Go. Tap the arrow to

choose from previously entered addresses.
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The Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder in the
Favorites folder in Internet Explorer on your PC will be
synchronized with your Rugged Handheld. This folder is created
automatically when you install ActiveSync.

Favorite Links

During synchronization, the list of favorite links in the Mobile
Favorites folder on your PC is synchronized with Pocket Internet
Explorer on your V38r. Both computers are updated with
changes made to either list each time you synchronize. Unless
you mark the favorite link as a mobile favorite, only the link
(and not the page) will be downloaded to your V38r, and you
must connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on
your PC.

Mobile Favorites

If you are using Microsoft Internet Explorer 5 or later on your
PC, you can download mobile favorites to your V38r. When you
synchronize your PC and V38r, the content of your mobile
favorites is downloaded to your V38r so that you can view
pages while you are not connected to your ISP or your network.

Use the Internet Explorer plug-in installed with ActiveSync to
create mobile favorites quickly.

To create a mobile favorite:

1 In Internet Explorer on your PC, click Tools, and then click
Create.

e To change the link name, enter a new name in the Name
box.

* To change how often the mobile favorite is updated, select
a desired update schedule under Update.

2 Click OK. Internet Explorer downloads the latest version of
the page to your PC.

3 If you want to download the pages that are linked to the
mobile favorite you just created, right-click the mobile
favorite and then click Properties. On the Download tab,
specify the number of links deep you want to download. To
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conserve memory on your V38r, download only one level of
links.

4 Synchronize your V38r and PC. Mobile favorites that are
stored in the Mobile Favorites folder in Internet Explorer are
downloaded to your V38r.

NOTE: If you do not specify an updated schedule, you must
manually download content to keep the information updated on
your PC and V38r. Before synchronizing in Internet Explorer or
your PC, click Synchronize on the Tools menu. You will see
the last time content was downloaded to your PC, and you can
manually download if needed.

NOTE: You can add a button to the Internet Explorer toolbar for
creating mobile favorites. In Internet Explorer on your PC, on
the View menu, click Toolbars, and then click Customize.

Conserving Memory

Mobile favorites take up storage memory on your V38r. Follow
these tips to minimize the amount of memory used:

e Use ActiveSync settings to turn off pictures and sounds for
the Mobile Favorites information type or to stop some
mobile favorites from being downloaded to your V38r. For
more information, see ActiveSync Help.

e Limit the number of downloaded linked pages. In Internet
Explorer on the PC, right-click the mobile favorite you want
to change, and then click Properties. On the Download
tab, specify 0 or 1 for the number of linked pages you want
to download.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to
personalized content and thousands of popular Web sites. You
subscribe to AvantGo channels directly from your V38r. Then
you synchronize your V38r with your PC or connect to the
Internet to download the content. For more information, visit
the AvantGo Web site:

http://www.avantgo.com/frontdoor/learn_more.html

To sign up for AvantGo:

1 In ActiveSync options on the PC, turn on synchronization for
the AvantGo information type.

2 In Pocket Internet Explorer on your V38r, tap the Favorites
button to display your list of favorites.

3 Tap the AvantGo Channels link.
4 Tap the Activate button.

5 Follow the directions on the screen. You will need to
synchronize your V38r with your PC, and then tap the My
Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels
link in your list of favorites to see a few of the most popular
channels. To add or remove channels, tap the Add or Remove
link.
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Chapter 8: Getting Connected

This chapter explains how to connect your V38r to the Internet
or to a network using a wireless connection. This chapter also
explains how to connect with other mobile devices or to your PC
using an infrared (IR) connection.

Connecting to a Network or the Internet

You will need a Network Encryption key from your IT
Administrator for this procedure.

1

Click Start > click Settings > click the System tab at the
bottom of the screen > VBC Utility > click YES to enable the
Wireless Card.

Wait for the list of wireless APs (Access Point) to appear. If
you do not see the AP that you want, click Settings. Select
the AP that is available.

The Network Key screen appears. Enter the web encryption
from your Administrator. Click the Network Key tab.

Clear the box next to "The key is provided for me
automatically.” Then, enter your network key in the
network key field.

Click OK at the top of the screen. Wait a few >
seconds till you see the symbol at the top of the Q
screen that looks like a beacon as shown on the <

right to indicate the status. Also, notice the status llll_
bar at the bottom of the screen.
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Using an Infrared Connection

An infrared (IR) connection will allow you use your V38r to
exchange information (such as contacts and appointments)
with other mobile devices as well as your PC. (For more
information, see “Using Microsoft ActiveSync” in Chapter 4.)

Use the infrared (IR) port on the V38r to exchange (send/
receive) files with another mobile device.

Sending Information

1 Switch to the program in which you created the item you
want to send, then locate the item in the list.

2 Align the IR ports so that they are unobstructed and within a
close range.

CAUTION: If the devices are too far apart or if something
blocks the path between the two ports, data might not be sent
or received correctly.

3 Press and hold the item, then tap Beam Item on the pop-up
menu.

NOTE: You can also send items, but not folders, from File
Explorer. Press and hold the item you want to send, then tap
Beam File on the pop-up menu.

Receiving Information
1 Align the IR ports so that they are unobstructed and within a
close range.

2 Tap [, tap Programs, then tap Infrared Receive.

3 Have the owner of the other device send the information to
you. Your V38r will automatically receive it.
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Chapter 9: Troubleshooting
and Maintenance

This chapter gives solutions to common V38r problems you
may encounter when using the device. It also provides
guidelines on taking care of your V38r.

NOTE: If you encounter a problem you cannot solve, contact
your reseller or ViewSonic Customer Support. See the
“Customer Support” section at the end of this chapter.

Reset the V38r

CAUTION: You loose all customization in DRAM (like files, programs,
and settings) with a Cold or Warm reset. As a precaution, before
removing the battery, we recommend that you drag any changed files
that you want to protect to the device’s Permanent Storage folder.

Cold Reset

If your V38r locks up or does not respond to the stylus, remove the main
battery. Open and remove the back cover by turning the latch as shown
on page 9. Then take out the battery.

Warm Reset

A warm reset may be required on rare occasions where your V38r
completely locks up. To do a warm reset, press and hold both the
POWER BUTTON and the HOME button for four (4) seconds.

Firmware Image Upgrade

From time to time ViewSonic may offer a firmware image upgrade for
V38r hardware users. For current information visit our web site at
viewsonic.com or check with your IT Administrator.
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Restoring Factory Defaults

In some cases, you may need to restore your V38r to the
factory default settings by clearing the memory (RAM) from
your V38r like when the following happens.

e When your V38r does not respond after being reset.
e When you forget your password.

Clearing the memory means all data you have entered in RAM,
including all files, system settings, and additional programs you
have installed, will be erased. (Programs installed to ROM at the
factory are not affected.)

CAUTION:

e To ensure the integrity of your data if it becomes
necessary to clear the memory, you are advised to
regularly back up to your PC (using ActiveSync), or
to an optional SD card (using the backup
application). For more information on backing up
data, see the "Backing Up Data” section in this guide.

e Do not remove the battery unless it is necessary. If
you remove the battery door, all data is lost.

To clear the memory from your V38r:

1 Disconnect all cables, including the AC adapter, from your
V38r.

2 To clear memory, do a hard reset on the back of the unit and
remove the main and backup battery. For more information,
see the section Reset the V38r in this guide.

IMPORTANT: If the battery runs completely out of power
and is not re-charged in time, the memory of your V38r will
be cleared.
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Power Problems

Power does not turn on when using battery power
e The remaining battery power may be too low to run your
V38r. Connect the AC adapter to your V38r and to external
AC power. Then, turn on your V38r. (Charge the battery
whenever possible to avoid running out of battery power
and thus loosing data.)

Battery runs out of power quickly
e You might be using your V38r in ways that drain power
quickly. For more information, see the section "Managing
Power” in this guide for tips on saving power.
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Memory Problems

If a warning message of not enough memory appears due to a
memory allocation problem, try the following to free memory
on your V38r.

CAUTION: Be discreet when you delete files. Deleting
files of which the function is unknown can cause
programs or features to malfunction. It is recommended
that you create a backup before deleting files.

e Delete files you no longer need. Tap g5, Programs, and
then File Explorer. Press and hold the file you wish to
delete, then tap Delete on the pop-up menu. To find your
largest files, tap g then Find. In the Type list, tap Larger
than 64KB, then tap Go.

e Remove programs you no longer need. Tap g5, and then
Settings. Tap System tab, then tap Remove Programs.
Tap the program you want to remove then tap Remove.

e In Internet Explorer options, delete all files then clear
history. In Internet Explorer, tap Tools then Options. Tap
Delete Files then Clear History.

e If you are copying files from a computer or other device to
your V38r, try adjusting the slider in the Memory setting.
Tap g then Settings. Tap System tab, then tap Memory.
Check to see if you can manually move the slider before
copying files.

Stop programs you are not currently using. In most cases,
programs automatically stop to free needed memory. However,
in some situations, such as when confirmation dialog boxes are
waiting for a user response, the program may not be able to
automatically stop. To check the state of your active programs,
tap g then Settings. Tap System tab, tap Memory, then
Running Programs. Tap the program you want to view then
tap Activate. Close any open windows or messages and return
the program to list view. If this does not work, you can stop the
program manually. First, make sure that your work is saved by
closing open items and return the program to list view. Then,
stop the program by tapping Stop or Stop All on the Running
Programs tab.

Reset your V38r as described earlier in this chapter.

If you have an SD card, move data to the SD card as follows:
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e Tap [, Programs, then File Explorer. Press and hold the
file you want to move, then tap Cut. Browse to My
Documents folder in the SD card folder, tap Edit, then
Paste. Files stored in folders other than My Documents or
stored in subfolders within subfolders in My Documents
may not show up in the list view of some programs. When
using Notes, Pocket Word, or Pocket Excel, you can also

move files by opening the item then tapping Tools or Edit
then Rename/Move.

Files stored in folders other than My Documents or stored
in subfolders within subfolders in My Documents may not
show up in the list view of some programs. When using
Notes, Pocket Word, or Pocket Excel, you can also move

files by opening the item then tapping Tools or Edit then
Rename/Move.
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Screen Problems

Screen is off

If the screen does not respond, even after you press the power
button, try the following until the problem is solved:

e Connect the AC adapter to your V38r and to external AC
power, then

e Reset your V38r as described in “"Resetting Your V38r”
earlier in this chapter.

Screen responds slowly
e Make sure that your V38r is not running out of battery
power or running many active programs. If the problem
still exists, reset your V38r as described in “Resetting Your
V38r” earlier in this chapter.

Screen freezes
e Reset your V38r as described in “Resetting Your V38r”
earlier in this chapter.

Screen is hard to read
e Make sure that the backlight of the display is on.

e Move to a location with enough light.

e If you are having a hard time reading a document on the
screen, try adjusting the zoom percentage or text size.

- In Notes, tap Tools, then select a zoom
percentage.

- In Pocket Word and Pocket Excel, tap View, tap
Zoom, then select a zoom Percentage.

- In Pocket Internet Explorer, tap View, tap Text
Size, then select a size.

- In Calendar, Contacts, and Tasks, tap Tools, tap
Options, then select Use large font.

Inaccurate response to stylus taps

Realign the touch screen. Tap g, then tap Settings. Tap
System tab, then tap Align Screen. If you cannot realign the
touch screen, turn off the V38r. Press and hold the scroll dial,
then press the power button to turn on the V38r. You should
now be able to start the touch screen alignment process.
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V38r Connection Problems
USB Dock/Cradle Connection Problems

e Make sure that you installed the correct version of
ActiveSync on your desktop PC. Install the version
ActiveSync included with your V38r.

e Make sure that your V38r and your desktop PC are turned
on.

e Make sure that you do not have any other active
connections.

e When using the USB cradle, make sure that your V38r is
properly seated.

e Make sure that the cable is securely plugged into the USB
port on your desktop PC. Connect the USB cable directly to
your desktop PC — do not run the cable through a USB
hub.

e Make sure that the USB connection is enabled in
ActiveSync on your desktop PC. If the USB connection is
already enabled, disable the USB connection, close the
Connection Settings window, and then reopen and re-
enable the USB connection.

e Reset your V38r before connecting the USB cable. (See
“Resetting Your V38r” earlier in this chapter.) Always
disconnect your V38r before you restart your desktop PC.

e Connect only one V38r or personal digital assistant to your
desktop PC at a time.

Infrared Connection Problems

e Transfer only one file, or no more than 25 contact cards, at
a time.

Position the IR ports so that they line up at a distance less
than 20 cm (8 inches) but more than 5 cm (2 inches) apart.

Make sure that there are no obstacles between the two IR
ports.

Adjust the room lighting. Some types of light interfere with
IR communications. Try moving to a different location or
turning off some lights.
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Care and Maintenance

Taking good care of your V38r will ensure trouble-free operation
and reduce the risk of damage to your V38r.

General Guidelines

e Keep your V38r away from excessive moisture and extreme
temperatures.

¢ Avoid exposing your V38r to direct sunlight or strong
ultraviolet light for extended periods of time.

e Do not place anything on top of your V38r as this may
damage the display.

e Do not drop your V38r.
e Store your V38r in a protective case when not in use.

e The screen surface is easily scratched. Use only the stylus
to tap on the screen. Avoid touching it with your fingers,
pens, or pencils.

e Never clean your V38r with the power on. Use a soft, lint-
free cloth moistened with water to wipe the screen and the
exterior of your V38r.

¢ Never use paper towels to clean the screen.

Travel Guidelines

e Before traveling with your V38r, back up your data. As an
added precaution, bring along a backup copy.

e Turn off your V38r and disconnect all external devices.
e Make sure that the battery is fully charged.

e Take the AC adapter with you. Use the AC adapter as the
power source and as a battery-recharger.

e Hand-carry your V38r in a protective case.

e Consult the airlines first before using your V38r on the
plane. You need to be very careful when using electronic
devices during the flight.

e If you plan to travel abroad with your V38r, consult your
dealer for the appropriate AC adapter for use in your
country of destination.
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Customer Support

For technical support or product service, see the table below or —
contact your reseller.

IMPORTANT:
e You will need to provide the product serial number
(on the back of the V38r).

e Before sending the V38r out for service, be sure to
back up all data and remove all third party software.
See the Data Loss Disclaimer in the Appendix

T = Telephone
F = FAX

Country/Region Website / Email

United States www.viewsonic.com/support T: (800) 688-6688
vstech @ viewsonic.com F: (909) 468-1202

www.viewsonic.com/support T: (800) 688-6688
vstech @ viewsonic.com F: (909) 468-1202
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Chapter 10: Appendix

Regulatory and Safety Information

USA

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiated radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipment and receiver.

-Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

-Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the party responsible for
compliance could void the user‘s authority to operate the equipment.

This device and its antenna(s) must not be co-located or operating in conjunction with
any other antenna or transmitter.

This EUT is compliance with SAR for general population /uncontrolled exposure
limits in ANSI/IEEE C95.1-1999 and had been tested in accordance with the
measurement methods and procedures specified in OET Bulletin 65 Supplement C.

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. In order to avoid the possibility of exceeding the FCC
radio frequency exposure limits, human proximity to the antenna shall not be less than
1.5cm during normal operation.

Canada
This Class B digital apparatus meets all requirements of the
Canada Interference-Causing equipment regulations.

Cet appareil numerique de Classe B respecte toutes les
exigences du Reglement Canadien sur le materiel brouileur.



European Regulatory Notice

Products with the CE mark comply with both the
Electromagnetic Compatibility Directive (89/336/EEC) and the
Low Voltage Directive (73/23/EEC) - as mandated by Directive
93/68/ECC - issued by the Commission of the European
Community.

Compliance with these directives implies conformity to the
following European standards:

EN55022: Radio disturbance characteristics
EN55024: Immunity characteristics
EN6100-3-2: Limits for harmonic current emissions

EN6100-3-3: Limitation of voltage fluctuation and
flicker in low-voltage supply system

EN60950: Product Safety

Battery Replacement

The device has two batteries: one is under the back cover as
shown on page 9. The other battery is a Lithium Ion battery
inside the device. The Lithium Ion battery maintains system
configuration information.

If the device does not maintain system configuration, do not
attempt to replace the internal Lithium Ion battery
yourself. Doing so may void the warranty. This battery can
only be replaced by authorized ViewSonic technician. Contact
ViewSonic for service contact information. See the
Specifications in this guide for part numbers.
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About the AC Adapter

CAUTION: Only use the AC adapter (Achme/AM138B05507)
supplied with your Rugged Handheld V38r. Using another type
of AC adapter will result in malfunction and/or danger.

IMPORTANT: This product is intended to be supplied with a
Listed Power Unit marked “LPS"” and output rated 5V/3A.

The AC adapter is designed to ensure your personal safety and
to be compatible with this equipment. Please follow these
guidelines:

e Do not use the adapter in a high moisture environment.
Never touch the adapter when your hands or feet are wet.

¢ Allow adequate ventilation around the adapter. Avoid
locations with restricted airflow.

e Connect the adapter to a proper power source. The voltage
and grounding requirements are found on the product case
and/or packaging.

¢ Do not use the adapter if the cord becomes damaged.

e Do not attempt to service the unit. There are no
serviceable parts inside. Replace the unit if it is damaged or
exposed to excess moisture.

About Electrostatic Discharge

Electrostatic Discharge Warning

Electrostatic discharges can interfere with the normal
functioning of electronic devices. Your Rugged Handheld can
behave abnormally owing to such an event, resulting in the
possible data corruption or loss of unsaved data. To recover
from this, reset your Rugged Handheld as described in this User
Guide.

NOTE: To avoid losing data due to electrostatic discharges or
other types of events, it is recommended that you regularly
save and backup data as described in this User Guide.
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Optional Accessories
The Dock/Cradle

The optional V38r dock/cradle permits easy connectivity to
external USB devices, AC power, multi-pack charging, and
serial communications. To use the cradle, plug the cradle into
AC power and place the V38r in the cradle. IMPORTANT:
When mounted in the cradle, the V38r's external USB port
become inactive.

: V38r mounted
Optlgpaa(;lgock/ in the dock

Multi-pack charging
USB-B AC power

USB-A Serial communication

Back of dock/cradle
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Commercially Available Accessories

External USB Keyboard and Mouse

You can attach a USB external keyboard or mouse to the
cradle’s USB-A port or the communication dongle.
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Limited Warranty
Rugged Handheld Products

What the warranty covers:

ViewSonic® warrants its Rugged Handheld products to be free from defects in material and
workmanship during the warranty period. If a Rugged Handheld product proves to be defective in
material or workmanship during the warranty period, ViewSonic will, at its sole option, repair or replace
the product with a like product. Replacement product or parts may include remanufactured or
refurbished parts or components. ViewSonic provides no warranty for the third party software included
with the product. For specific warranty information, please see the EULAs included with the product.
ViewSonic does not warrant that software will meet your requirements or that operation of software will
be uninterrupted or error free. VIEWSONIC AND ITS SUPPLIERS DISCLAIM ALL WARRANTIES AND
CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NONINFRINGEMENT.

How long the warranty is effective:*
ViewSonic Rugged Handhelds are warranted for one (1) year for all parts (except software) and one (1)
year for all labor from the date of the first consumer purchase.

Who the warranty protects:
This warranty is valid only for the first consumer purchaser.

What the warranty does not cover:
1. Software
2. Any product on which the serial number has been defaced, modified or removed.
3. Damage, deterioration or malfunction resulting from:
a. Accident, misuse, neglect, fire, water, lightning, or other acts of nature, unauthorized product
modification, or failure to follow instructions supplied with the product.
. Repair or attempted repair by anyone not authorized by ViewSonic.
. Damage to or loss of any programs, data or removable storage media.
. Software or data loss occurring during repair or replacement.
. Any damage of the product due to shipment.
Removal or installation of the product.
. Causes external to the product, such as electrical power fluctuations or failure.
. Use of supplies or parts not meeting ViewSonic’s specifications.
Normal wear and tear.
Any other cause which does not relate to a product defect.
4. Removal installation, and set-up service charges.

How to get service:

1. For information about receiving service under warranty, contact ViewSonic Customer Support. You
will need to provide your product’s serial number.

2. To obtain service under warranty, you will be required to provide (a) the original dated sales slip, (b)
your name, (c) your address, (d) a description of the problem, and (e) the serial number of the
product.

3. Take or ship the product freight prepaid in the original container to an authorized ViewSonic service
center or ViewSonic.

4.  For additional information or the name of the nearest ViewSonic service center, contact ViewSonic.

Limitation of implied warranties:

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WHICH EXTEND BEYOND THE DESCRIPTION
CONTAINED HEREIN INCLUDING THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

Exclusion of damages:

VIEWSONIC’S LIABILITY IS LIMITED TO THE COST OF REPAIR OR REPLACEMENT OF THE PRODUCT.

VIEWSONIC SHALL NOT BE LIABLE FOR:

1.  DAMAGE TO OTHER PROPERTY CAUSED BY ANY DEFECTS IN THE PRODUCT, DAMAGES BASED
UPON INCONVENIENCE, LOSS OF USE OF THE PRODUCT, LOSS OF DATA, LOSS OF TIME, LOSS
OF PROFITS, LOSS OF BUSINESS OPPORTUNITY, LOSS OF GOODWILL, INTERFERENCE WITH
BUSINESS RELATIONSHIPS, OR OTHER COMMERCIAL LOSS, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

2. ANY OTHER DAMAGES, WHETHER INCIDENTAL, CONSEQUENTIAL OR OTHERWISE.

3.  ANY CLAIM AGAINST THE CUSTOMER BY ANY OTHER PARTY.

Effect of state law:

This warranty gives you specific legal rights, and you may also have other rights which vary from state to
state. Some states do not allow limitations on implied warranties and/or do not allow the exclusion of
incidental or consequential damages, so the above limitations and exclusions may not apply to you.

Sales outside the U.S.A. and Canada:

For warranty information and service on ViewSonic products sold outside of the U.S.A. and Canada,

contact ViewSonic or your local ViewSonic dealer.

* For Europe: This Limited Warranty is effective in Europe for two (2) years for all parts (except
software) and two (2) years for all labor from the date of the first consumer purchase.

ViewSonic Rugged Handheld Warranty (V1.0) Release Date: September 9, 2002

TS QTT0 Qo000
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Specifications

Processor Intel® XScale® 416MHz CPU with 64MB flash
oS Microsoft® PPC2003 (included)

Memory 64MB SDRAM (expandable to 128MB)
Display 240x320 transflective TFT panel

256K colors (3.5” diagonal)
Contrast Ratio: 5:1 (B/L off); 80:1 (B/L on)
Brightness: Typical 90 nits (with touch panel)

Touch Screen

4-wire resistive type

Punch life: 1M cycles with 250g force, 2 times/sec
Stroke life: 100K cycles with 2509 force, repeat 1 inch
Hardness: 3H

SD Memory Slot

User accessible SD slot on the left side of unit

Cradle Support USB, and one serial RS232 port
Part Number: CDLE-001
Dimensions 145mm (L) x 83mm (W) x 32mm (H)
50mm (H) in the imager side
Weight <500g including battery pack and standard Expansion

hatch cover, excluding Scanner engine and WWAN
solution

Communication

IrDA (SIR 115 kbps)

Wireless
Communication

WLAN 802.11b/g standard or Avalon RF link

Integrated For WLAN, BT and WWAN
Antenna
Batteries Standard 3.7V, 1800mAhr removal battery pack. Up
battery to 3 hours life (depending on use and
configuration)
Part Number: BAT-001
Extended 3.7V, 3600mAhr removable battery pack.
battery- Over 8 hours operation with full WLAN/BT
optional connection
Backup 7.2V 40mAh Ni-MH ...TBD
battery- Part Number: BAT-002
internal
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Power 15 w total

Consumption

Environment Operation:  14° F - 113° F (-10° C - 45° C)
non-condensing humidity, 0 - 3,000 meters

Storage: -4°F -158° F (-20° C - 70° C), 10% - 85%

non-condensing humidity, 0 - 12,000
meters

1-D Imager 1-D CCD Image engine

Fingerprint Support Authentec AES3400

Miscellaneous

DC power jack; cradle, Internal Speaker, Mic, Stylus,
Stylus Tether, protective front cover

Regulatory
Approvals

FCC, UL, CE Mark and Radio Country Approvals:
US/Canada, R&TTE

Basic Software

Windows PPC2003
Internet Explorer
Windows Explorer

Microsoft Inbox
Microsoft File Viewers
MS Excel Viewer

Media Player MS Image Viewer
MS WordPad MS PDF Viewer
Solitaire MS PowerPoint
Microsoft ActiveSync Viewer
MS Word Viewer

RF module
option

Avalon RF Sub-system to support non-line of sight range
is 4 miles with conditions

Echo cancelling
option

Hardware echo cancelling for VolP

HHP 1T4010
option

2-D barcode engine for PDF417 decoding

Miscellaneous
Part Numbers

Clip-001
AC Adapter—001
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Data Loss Disclaimer

Before sending the V38r out for service, be sure to backup all
data and remove all third party software.

With respect to all service provided, it is your responsibility to
backup the contents of your V38r, including any data you have
stored or software you have installed on the V38r. It is likely
that the contents of your V38r will be lost in the course of
service and ViewSonic will not be responsible for any damage
to or loss of any programs, data or other information stored on
any media or any part of any Product serviced hereunder.

IF DURING THE REPAIR OF THE PRODUCT THE CONTENTS OF
THE V38r ARE ALTERED, DELETED, OR IN ANY WAY MODIFIED,
VIEWSONIC IS NOT RESPONSIBLE WHATSOEVER. YOUR
PRODUCT WILL BE RETURNED TO YOU CONFIGURED AS
ORIGINALLY PURCHASED (SUBJECT TO AVAILABILITY OF
SOFTWARE).

Be sure to remove all third party hardware, software, features,
parts, options, alterations, and attachments not warranted by
ViewSonic prior to sending the product to ViewSonic for service.
ViewSonic is not liable for any loss or damage to these items.
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